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Motivation

Previously, you’ve put together your circuits on a breadboard. Why should
you bother with making a Printed Circuit Board (PCB)? Whenever you
want to make multiple copies of your circuit, moving to a PCB-based design
very quickly becomes worth your while. A printed circuit board can also
be a better option when it comes to dealing with high-frequency signals or
when measuring phenomena occurring over very short timescales. Another
factor might be that breadboard-based designs tend to suffer from crosstalk
and significant noise pickup. Overall, surface-mount designs perform better
than circuits with through-hole components, and can be cheaper!

The goal for this worksheet is to cover the most useful first stages of
the PCB design learning curve. We’re not going to cover everything, but
will instead emphasize that there’s really just a small subset of the options
available that you will need in order to draw up a useful circuit schematic
and then turn that into a board layout design that you can submit for
fabrication.

There are many free PCB design programs out there. KiCAD has the
advantage that many manufacturers (and distributers such as Digi-Key,
Mouser, and Jameco) specify the “footprint” of their components as Ki-
CAD libraries, but KiCAD itself has long been little more than a collection
of programs held together by a mostly-common interface. FLUX.ai is a
newer effort that aims to incorporate KiCAD libraries into a more coherent
software package, which we intend to explore in the future. For now, we’ll
discuss KiCAD.

Online Resources

• KiCAD: Download and install KiCAD 6 onto your computer.
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• Simple supplement: Build Electronic Circuits site

• Full tutorial: Getting Started in KiCAD

Your first printed circuit

We’re going to keep it simple by starting with an op-amp based non-inverting
amplifier. As is traditional for any electronic design, we start with a sketch
on the back of a napkin. (See figure 1.)
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Figure 1: Typical napkin-scrawl. (Spilled beer omitted for clarity.)

We want to change this rough sketch into a testable schematic, and from
there into a board design that can be fabricated and built into a working
circuit. Accordingly, the two main KiCAD programs we will use here are
the Schematic Editor and the PCB Editor. These both do just what their
titles indicate: the first one lets you build a schematic, and the second one
lets you turn that schematic into a board design.

Schematic step-by-step instructions

1. If you have not done so already, download and install and run KiCAD.

2. Create a new project, and click the ‘Schematic Editor’ icon. If working
correctly, a blank template will appear. It is well worth your while to

2

https://www.build-electronic-circuits.com/kicad-tutorial/
https://docs.kicad.org/6.0/en/getting_started_in_kicad/getting_started_in_kicad.html


go to ‘Page Settings’ under the File menu to set the paper size, author,
title, version number, etc.

3. Now let’s add parts. Third-down on the right hand side there’s an
icon that looks like an amplifier. Click it (or press ‘a’) to select the
‘add parts’ tool, then click on the schematic. After a moment or
two, approximately 17,000 options will appear (not an exaggeration).
Fortunately, there’s a filter available: type in ‘TL061’ for a TL061
op-amp, and place it on the schematic. Continue this process for the
resistors and capacitors, placing them roughly where they’ll be needed.
Note that there are options for which symbol to use: if you filter by
‘resistor’ you will see many options including ‘R’ and ‘R US’. The
symbol you are most familiar with is ‘R US’. (For the sake of anyone
else who has to look at your schematic, consistency is recommended!)

4. As you are placing the parts, note that pressing ‘r’ rotates the part
90◦ counterclockwise. You can also rotate parts later by right-clicking
on them and selecting from the menu of options given.

5. This board will need connections for your input and output signals.
For high-frequency signals, these are best provided by BNC or other
co-axial connectors. You may want to mirror one of the connectors,
which you can do by right-clicking on the connector after it’s placed.

6. We also need three power connections: +V , −V , and GND. These
can be physically provided by screw terminals. You should also place
voltage symbols, such as +12V and GND, with the power placement
tool just below the ‘add parts’ tool on the right. One convenient trick
is to place multiple symbols: you can for example put as many GND
symbols on the schematic as you like, and they’ll all connect to the
same network. I make use of this trick extensively on my designs: I’ll
have +12V symbols on the op-amp and then have the screw-terminal
block with +12V somewhere in the corner of the schematic.

7. By this time you probably have a bunch of parts scattered onto the
schematic and it’s a mess. That’s fixable. If you use the selection tool
(the arrow at top of the right of the window) and click on any part
you can Move it by pressing ‘M’. You can Rotate it also (‘R’).

8. For adding wires, the tool is the 5th one down on the right, it looks
like a diagonal black line. You can also select this tool by pressing
‘w’ for Wire, or by clicking on the terminals at the ends of each part.
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Now, wire up your circuit. Move/Rotate parts so that the schematic
is ‘pretty’, and make all the connections. As you are doing this, it may
be helpful to draG (‘g’) components instead of Move (‘m’) them. If you
draG them, the wires stay attached! (This is sometimes a convenient
way of checking whether the wire is attached.)

9. There are things to be very careful of when doing the wiring! Be sure
that the wires go to the terminals at the ends of the parts; otherwise
they’re not really connected. Also understand that crossing wires don’t
connect by default. In figure 2, −12V is not connected to GND! If
you want two wires to connect, use the Junction (‘J’) tool and click
on the intersection.

Figure 2: Screw-terminal power block segment of the schematic. The nega-
tive supply is not connected to GND.

10. KiCAD’s error-checker routines need to know where power is coming
in. To tell the program this, it’s necessary to attach a ‘Power Flag’
to the ±12V and GND symbols at some location in the schematic.
These are most easily found with the power placement tool. (I connect
them at the power/screw-terminal part of the diagram.)

11. It’s nice to have component values on the schematic. right-click each
resistor and capacitor and enter the value (‘v’) for that component. I
used r1 = 100kΩ and r2 = 10kΩ.1

1These particular values were chosen because we have an overdeveloped sense of humor.
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12. One more thing: The TL061 chip has two pins that we’re not using
in the napkin-based design shown in figure 1. Those pins are for the
offset adjust. If you would like an offset adjust trimpot in your circuit,
go ahead and connect one. Otherwise, we need to tell KiCAD that
those pins were not forgotten but were deliberately left disconnected.
The eighth icon down on the right lets you place ‘no-connect flags’ on
the circuit. Use this tool to put ×’s on the unused pins.

13. If everything looks good, now it’s time to fill in what KiCAD refers
to as the references. So far each part is ‘?’: R?, C?, etc. Rather
than change these all manually (and risking having two parts with the
same label) have KiCAD do it for you. Under the ‘Tools’ menu, click
‘Annotate Schematic’.

14. All done with the schematic? Any errors? We can check! Under the
‘Inspect’ menu, choose ‘Electrical Rules Checker’. Fix any errors it
flags, and you’re ready to start the second half of the process!

Board Layout step-by-step instructions

Now that we have a schematic, let’s turn that schematic into a board. First,
we have to tell KiCAD the ‘footprint’ for each piece. This is one of the
trickier parts of the process, and doing it right is key to success. KiCAD
then generates a ‘netlist,’ a list of part shapes and description of which pins
are connected to which other pins. We then arrange the parts on the board
and route the wires.

1. Under the ‘tools’ menu, select ‘Assign footprints’. KiCAD opens an-
other window with three columns: Footprint Libraries, Footprint As-
signments, and Filtered Footprints.

2. The Assignment column will be alphabetical, so start with C1. (For me
this was a 1µF bandwidth-limiting capacitor in the feedback network
on the op-amp.) We are introducing Surface-Mount Devices (SMD),
so in the Libraries column select the ‘Capacitor SMD’ library. The
right-hand column will now show all the footprints in that particular
library category. I cannot overemphasize this: The footprint you select
must match the part you intend to use. SMD parts come in a very
wide range of sizes and packages. Some of these are too small for
human placement! I personally am comfortable working with 0805-
sized parts, and although I have successfully hand-placed 0603 parts
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when necessary, I recommend selecting 0805 or larger. (The parts we’ll
be using in our ‘build’ worksheet are 0805 or 1206.) In addition, there
is the option of regular or ‘handsolder’ footprints. The handsolder pads
are slightly larger and easier to work with. Double-click the desired
footprint to assign it to selected part.

3. Assign the rest of the parts. The most common BNC connector is the
TEConnectivity 1478035 Horizontal, the TL061 is a SO-8 3.9x4.9mm,
and the screw terminal fits a 4Ucon horizontal with 3.5mm pitch.

4. So far, the op-amp specified in your design has been a TL061, but let’s
suppose that you were making a different circuit that required a higher-
bandwidth op amp, such as an LF411. Unfortunately, the default
KiCAD libraries do not include the component footprint for this part.
While it is possible for you to design your own, it is much simpler to
go online and download it from SnapEDA, which does require you to
register as a member of the community, but remains free so long as you
are downloading fewer than half a dozen footprints each week. Even
though it might, at first, look as though their version of the LF411 is
not a surface-mount component, that package choice really is included
in what you’ll download. [Again, distributers, such as SparkFun, all
provide links allowing you to download KiCAD component footprints
for everything they sell.] Once you’ve downloaded a library and model,
you can simply add that to the working folder of your project (so that
anyone you give that to will have all that they need). If you want
to add module for all of your future projects, select KiCAD Prefs ≫
Manage Symbol Libraries, and add what you wish.

5. Once all component footprints have been assigned, click Assign, and
then click OK.

6. Now it’s time to go lay out the board. Click the ‘Open PCB in Board
Editor’ icon at the top right. You will again get an engineering dia-
gram, but this time with a dark background. Set up the page details
with File/Page Settings.

7. Press F8 (or click ‘Update PCB from Changes Made to Schematic‘)
to have all your parts magically appear in a useless cluster with a
spiderweb of lines (usually referred to as a rats’ nest) showing what
should connect to what. This is your starting point for the circuit
layout, and it will not even be close to how things should be.
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8. Depending on your project, you may have a size constraint for the
board. In that case, you would draw the board outline now. (See step
15.) In this case, though, we’re going to build the circuit first and then
see what the board should be shaped like. (That’s often easier.) But
start thinking of the small middle area of this sheet as the board, and
put your parts on that board using Move and Rotate (‘m’, ‘r’) to place
them in a way that will minimize the tangle of circuit traces needed.

9. As you place parts you will notice that they snap to a grid. The default
grid size may be too large, feel free to change it. Also, be careful
when moving things: it’s possible to move parts of the footprint label
without moving the footprint, etc. Effective practice is to select one
of the pads and then press ‘m’ to move the entire part.

10. Once you have a reasonable part layout, start running wires between
pads to replace rats’ nest wires. Use the ‘Route Tracks’ tool, not the
‘Draw Lines’ tool. The board has two sides, front and back. With
through-hole electronics, the back side is preferred. With surface-
mount, though, the parts are on the front side and front-side traces
are preferred. Start with the short/obvious/easy wires on the front
side, but put off all of the GND connections (as we’ll do those last).

Effective Practice: The traces are made by etching away copper on the
board. If you have acute inside angles, etchant residue tends to stay
there and gradually eat at the board, potentially causing an eventual
failure. For this reason, avoid having traces meet at acute angles, and
two 45◦ angles are better than one 90◦ angle.

11. Once the easy connections are made, start filling in the longer ones.
(Again, don’t do GND yet; we’ll do that last.) You will eventually
find a trace that you can’t efficiently route on the front side without
traces crossing. To solve this, you’ll have to place a via to take the
signal to the other side of the board. Route the wire on one side until
you get to where you want to tunnel through the board. Click to end
the wire there, then press ‘v’ to place a via. Select the opposite layer
at the top of the window, and continue routing the wire on the new
side as needed.

Effective Practice: With wires going from a through-hole part to a
SMD part, it’s a good idea to start the wire on the back side at the
through-hole part, then bring it to the front to attach to the SMD
part. The board-fabrication houses I recommend all use plated holes,
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so this is not technically necessary, but it’s probably a good idea just
in case the board-fab house does not plate holes by default and you
forget to tell them to do so.

12. For the last set of connections, let’s make a ground plane. Select the
‘Add a filled zone’ tool (right side, 7th icon from the top) and use it to
draw a rectangle matching the border of the circuitboard. When the
pop-up window asks, tell it that the filled zone will be ‘GND’, on both
top and bottom Cu layers. Once completed, this filled ground plane
should connect the last of your rats’ nest wires and the ‘unrouted’
count at the bottom of the window should go to zero.

13. It’s not zero, is it? . . . Zoom in, find the unconnected wire, connect
it. Sometimes there’s just a small gap between the end of the trace
and where KiCAD thinks the trace should end. In extreme cases, I’ve
gone so far as to turn off all layers other than the rats’ nest, just to
see where the last problem was.

14. I have a touch of CDO2 so I tend to spend way too much time on
this, but go through and clean up the design a bit. Are your parts
aligned so the BNCs are an inch apart and extend the same dis-
tance? Would switching a pair of components, or rotating one, allow
for shorter/cleaner traces? Do you really need so many vias? If you
rip up and/or reroute any wires, the ground plane you made won’t
look right. Pressing ‘b’ redraws it.

15. If not done already, draw the edge of the board. Change the layer to
‘Edge cuts’ and draw a border using lines (not wires).

16. As long as you’re drawing the edge, put mounting holes in also. Click
the ‘Add a footprint’ tool, search for ‘hole’, and select the size of
hole you want to use. (M3 is standard, and works well with either
M3 screws or 4-40 if you’ve not switched yet.) You can’t delete the
(useless) text associated with these mounting holes, so we recommend
simply moving that to a location outside of the board area.

17. Now it’s time to do the silkscreen. This does not affect the function-
ality of the circuit, but it can make it easier for the user! Deselect
most of the layers, other than F.Cu, F.Silkscreen, F.Courtyard, and
Edge.cuts. Toggle layer F.Fab and decide whether any of the text in

2OCD, but properly alphabetized.
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that layer is something you want to have on the silkscreen layer. If
so, select the text and right-click on it. Select ‘Properties’ (or just
press ‘e’) and change the layer to F.Silkscreen. Move and/or rotate
component labels so that they’re all in reasonable locations.

18. Label the connections. −V , GND, +V , Input, Output. Use the ‘Text’
tool. Make sure the labels are on the F.Silkscreen layer!

19. Add your name and circuit information to the silkscreen. You can
do this on either the front or back: front is more visible but there’s
more room on the back. Use the ‘Text’ tool. If you put it on the back
silkscreen, make sure it’s reversed!

Generating Gerbers

I’ve given up on fabricating my own boards. Yes, I can do it and get reason-
ably good results, but fabrication houses are cheap and fast so I send them
out. It takes a week or less to get perfect boards with lovely silkscreens
and soldermasks and working vias. All fabrication houses use Gerber files
to make the boards. To generate your Gerber files,

• Select ‘Plot’ under the File menu. (Not ‘Print’.)

• The layers you should include (Front and back) are Cu, Paste, Silkscreen,
Mask, and Edge.Cuts.

• The rest of the defaults are usually right. Click ‘Plot’.

• Before you leave that page, also click the button to generate drill files.
The default format, Excellon, is the one you want.

Once that’s done, you’ll have an extra half-dozen .gbr and .drl files in
your working directory. Go back to the main KiCAD control program and
select the Gerber Viewer program. Open the Gerber files and make sure each
layer looks like what you want. Before spending money to have these fab-
ricated, you might print them out on paper, using a standard laser printer,
just to check that your components actually fit the footprints you’ve speci-
fied.

If you’re satisfied, and certain it’s right, gather all those .gbr files and
the .drl files into one .zip file and you’re ready to send them to fabrication.
If you plan on making twenty boards, we highly recommend that your order
should also include a stencil, which is used for quickly applying solder paste,
to all pads, on board after board, very quickly!
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The fab houses I use are

• AllPCB.com. This place is fast and cheap. I believe it’s located in
Guangzhou China, and my children assure me that they’re manufac-
tured by child slave labor but I’ve not been able to verify that. It
typically costs less than a dollar per board, and about $30 shipping,
and I get the boards in 5-8 days.

• Osh Park. These people are an aggregator: they collect a bunch of
orders, put the orders on one big circuitboard, and then have someone
else (child slave labor?) manufacture them and cut them apart. Fabri-
cation time can vary, depending on order volume, but board quality is
quite high and the boards are purple. They are a US company, if that
is of importance to you. Their cost is $5 per square inch, and boards
are ordered in multiples of 3. Submission is as easy as dragging a zip
file onto their web page.

There are other options also, of course: Google it if you don’t like either
of those. (If you find a US-based fab house for a reasonable price, let me
know.)

Submit your .zip file through the website of your chosen fab house, and
wait for a week. . . . Once you have a printed board in hand, you’re ready to
move on to our next worksheet, “How to attach Surface-Mount components
to a Printed Circuit Board (PCB).”
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